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1. Preface

1.1 Introduction
Welcome to the ARES-21 world!
This document is intended to ease your first introduction to ARES-Swimming. It has a description of

the main dialogs used in the program. Additionally, there are comments of how to get the most of the
program.

This document was made using software version ARES Swimming 2.04. That means you can have
some differences with your own program features or dialogs.

1.2 Connection to the IF-ARES

The connection to the IF-ARES is done by an RS-232 cable.

At start, the program checks if the IF-ARES is connected, and a message box appears if no
connection can be made. If this message box appears, the causes can be:

e The IF-ARES has NOT been switched on.

e The cable is not connected.

e The cable is connected to the wrong serial port. In this case, you can either move the cable
or select another port from the PC software.

If the program has found the IF-ARES, it launches the swimming module and the red LED on the IF-
ARES starts to blink. If another module is already active on the IF-ARES, you will be asked to switch it
off and on again.

1.3 General

On-line Help:
e Press F1 from any ARES-Swimming window to get this on-line help.

Keyboard accelerators in a dialog that is active (usually with a highlighted title bar):
o Use the WINDOWS method for the controls (buttons, checkbox...) that have an underlined
character in their text.

Example: Race is accelerated by depressing the keys <ALT> and <c> at the same time.

e Use the key combination for those controls or menu items that are followed by <xxx>.

Example: Next Heat <Ctrl N> is accelerated by depressing the key <Ctrl> and the key <N>
at the same time.

Keyboard accelerators in a dialog that may be active:

e The accelerators that are active wherever you may be in the ARES-Swimming application
can be recognized by a ‘"

Example : I<Ctrl F12> is an accelerator that is always available.
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Main window.
The main window has only a list of menus. When it is minimized, all the other windows of the program
are also minimized.

Change directory.

This dialog is accessed from the ARES-Swimming window, with the menu <File > Change data
directory>

The dialog <Change data directory> lets you decide where all the data will be stored.

We recommend you create a new directory for each day of competition. This will make it easier for you
to work with competitions with large entries or several competitions at one time. This will also help
maximise the program response times to file functions. To make a backup of a whole day of
competition, copy all the files from this directory.

When moving to an empty directory, all the tables and configuration details are taken from the default
directory ( \ares\swimm). It may be convenient to get some tables such as competitors or the records
table from the previous data directory. This can be done by checking the table copy checkbox.

1.4 Step by step
At first:
1. Synchronization of the IF-ARES (chapter 2)
2. Check or set the configuration of the pool (chapter 3.1)

Preparing a timetable:
1. Edit the competitions (chapter 5.1)
2. Edit the competitors table (optional) (chapter 5.2)
3. Edit the start lists (optional) (chapter 5.2.2)

Process a race:

1. Select the heat in the timetable and connect it to the <Race dialog>.(<Race> or a double
click on heat) (chapter 5.3)

Process the race

Check the final results on the <Result dialog> (chapter 5.4)

Press <End of Race> (for printing) (chapter 5.4.2)

<Next heat> or <Next event> or quit the <Race dialog>

aobrwbd
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2. Synchronization.

The synchronization dialog box is accessed from the ARES-Swimming window, menu <IF-ARES >
Synchro>.

It is used to set the day time on the IF-ARES.

You should synchronize the IF-ARES each time it is switched on.
If you don't, the first impulse on the start input will automatically synchronize it at 0:00.

The IF-ARES can only be synchronized once. If it has already been synchronized, either restart it, or
quit the synchro dialog.

It is important to have a correct day time in the IF-ARES because :
e The start impulses are recorded as a day time.
o If there is a backup system, they should have the same time.

Source:
o Direct : the IF-ARES will be synchronized when you press <GO>.
o Start :the IF-ARES will be synchronized when an impulse occurs on the start input.
e Synch : the IF-ARES will be synchronized when an impulse occurs on the synch input.

How to process:

Launch the synchro dialog box.

Enter the time in the entry fields (an empty entry field means 00).
Select the means of synchronization.

Press Go.

Wait for the trigger event to occur (if not direct).

agrON=
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3. Configurations

The configurations available from the main window are:

- Select the data directory.

- Configuration of the pool.

- Timing precision.

- Select the language and keyboard.

- Select the serial line.

- Scoreboard setup.

- Set Actions to do on end of race

- Record detection and updating

- Warning and display timer configuration for lanes
- Competition with or without reaction times
- Advanced sending data for scoreboard

3.1 Pool Configuration

(WelgisMEL Table |F-ARL
Foal...
Precisian...
Language...
Serial pors +
Scoreboard...

On end of race...
Becord management...
Lane options...

Feaction times
Fecords output...

This dialog is accessed from the ARES-Swimming window, with the menu <Configuration - Pool>

Connection of the harness:

The first three comboboxes describe the position and the connections of the harness to the IF-ARES.

1. Select which harnesses are connected and on which side.

2. Select which harness is connected to the Near End (HA1) input of the IF-ARES.
3. Select which side is the finish. ( or in some cases where all the starts are done).

These three entries are closely related.

Numbering of the lanes:

The other two columns describe the relations between the number of a lane module along the harness

and the lane number (written on the start platform).

1. Select the order of the modules along the harness.
2. Select the order of the lanes along the pool.

These two entries are closely related.

Example 1:
A pool with 8 lanes humbered from 1 to 8.

The module 1 is on lane 1, module 2 is on lane 2, and so on...
Module order: <1 2 3 4 5 6 7 8>
Lane order: <1 23 456 7 8>

Use the factory setting button <8/ 8 >

Example 2:
In a 10 lanes pool that is set as a 8 central lane pool:

The module 1 is not used, but the module 2 is set for lane 1 and so on...

<2 345678 9>
<l 2345¢6 78>

Module order:
Lane order:
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Use the factory setting button <8 /10 >

It is recommended you test these settings with the test window (launched by the test push-button).
Please work with a partner who presses every contacts and check on the test window if it's correct
one.

3.1.1 Connection to the harness
This dialog is accessed from the <Pool configuration>, with the button <Contacts>.

Lanes connections :

Normal configuration with a touchpad, a platform, and a backup button. (For an Omega Electronics
Interface)

—Mear End —FarEnd Start
[+ Touchpad ¥ Tauchpad € Start System [nomally closed)
¥ PFlatform [ Platform
" Button [normally apen]
% Platform tupe i+ Platfarm bpe
" Button type i~ Buttan hype
= | Eusttar = Buttar
W Button 2 ¥ Button 2
= Bt 2 = Buttor 2 O, Cancel

For configuration with 3 buttons, the official time is the middle one (according to FINA rules).

With Daktronics interface you can use 3 buttons for the backup time, so the intermediate time shall be
the official backup time. If only two buttons are available the official backup time shall be the adverage
of those two buttons. If only one button is available the time of those button shall be the official backup
time.

Start connection:

You can also set the type of your start system. (Standard Start Systems are normally closed)

Note: The start contact configuration is checked when the synchronisation (chapter 2) is done by
the start.

3.2 Timing precision
This dialog is accessed from the <ARES-Swimming> window, with the menu <Configuration -
Precision>

The timing precision can be changed here and will affect any subsequent acquisition of times.

3.3 Language

The language selection is used to change, the program texts (menus, button, ...).
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Note: The texts for the style, length, round and category of a competitions are only changed when
changing to a new data directory.

The keyboard selection is used to change the accelerators.

3.4 Reaction times
This option enables the detection of the start reaction time.

The reaction times appear on the <Race dialog> and are also sent to the SCB and the GP outputs.

4. The test window

This is a tool that helps you to check that the configuration is correct. This dialog is accessed from the
<ARES-Swimming> window, with the menu <Configuration > Precision > Test>

This window displays in large characters the number of the lane that has been activated.
The contact (touchpad, platform and button - Glossary, chapter13) are also displayed.
When a touchpad on the finish end has been activated, the sides of the window become black.

When a touchpad on the opposite end to the finish (e.g. 50m) has been activated, the sides of the
window are half black, half white.

Lane entry: lets you select which lanes should be tested
Enter * for all lanes
Enter 2 3’ forlanes 2 and 3

Hold time entry: lets you choose how long (in seconds) the number of the lane should be displayed.
Enter ‘2’ for displaying a number for 2 seconds.
Enter ‘0’ to prevent the number from being erased before the next touch.

4.1 Disconnect the harness
This function is available from the 'Race dialog' with <Windows - Timetable(F8) > Race > Options
- Enable Harnais>

In order to make some connection tests with some external system (SCB or data handling) while the
pool is full of swimmer who 'warm up', it is possible to ask the programm to disconnect the harnesses
by software.

WARNING: in this mode, no events are received from the pool. This function should be used only
for tests.

ARES Swimming - Page 10
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5. Timetable dialog

& Timetable 00:00:00 M= B
fLictions  Sort
Competition

-1 Gualf. 00:00 M 100 m FR Edit competition... |
-2 Finales 115 MO0 m EH

Tt — Connected to.

Race. |

Result...

¥ 1: Follows race

Ewent..

¥ 2 Follows race

Start list... |

This dialog is accessed from the <ARES-Swimming> window, with the menu <Windows - Timetable
(F8)>.

From this dialog, you can start various actions from push-buttons:

- Edit a competition (select event number, distance, style, etc.). A competition is a group of heats.
- Edit the start list for the selected heat.

- Launch the race dialog for the selected heat.

- Connect a competition to the <Results dialog>.

- Connect a competition to the <Events dialog>.

Usually, the heat that is on the race dialog is also connected to the classify and events dialogs.

In certain circumstances, such as to print or to review the events of a previous race, you may want to
connect to the <Results dialog> a heat other than the one that is current. This can be done by
unchecking the <1: follows race> box.

From the menu, you can:
- Delete a heat .
- Delete a whole competition.

You will get a message box to confirm the deletion.

Notes: You can edit a competition by double clicking on it in the competitions listbox.
You can launch the race by double clicking on it in the heats listbox.

- Import startlist from Meet Manager software for the selected competition and heat. It's only
available if a computer running Meet Manager is connected to the GP port of the ARES.

ARES Swimming - Page 11



Ei SPORTS luwmo

5.1 Editing a competition
Competition M= =

~EventNb ———— ~Date Start time
|2 IFinaIes j ﬁumsm ’718:15 —‘

~Race

I 100 m j IFreest_l,lIe j IMen j

— Title far Print

IVII Swirmming *orld Championzhips Roma'34

r— Title for Scoreboard
|H0ma'84

—dJudge name for print

|Gon2alez Rodrigo

Coee_|

To get the <Editing a competition dialog> :
o Be sure the timetable is active.
o To edit a new competition, select the line < +++ > in the competition listbox and press the
<Edit competition> button.
o To edit an existing competition, select it in the competition listbox and press the <Edit
competition> button.

The event number and the round:
o for an existing competition, they cannot be changed.
e for a new competition, if they are the same as an existing competition, the <OK>
pushbutton will be disabled.

The length, style and category:
e They are used for a correct setting for the number of laps, records, and prints.
e The length,style and category values can be changed

The date, time and title:
e They are only used for the printed results.

Title line for the prints:
e The first title line is used for the printed results.

Title line for the scoreboard:
The second title line is sent to the scoreboard depending of the scoreboard Type. For more
information about the SCB outputs, see Scoreboard, chapter 8.

Some automatic fields may be inserted. They are:
%0 : Event number.
%1 : Round.
%2 : Heat number.
%3 : Category.
%4 : Length.
%5 : Style.
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Example :
Using these automatic fields, it is possible to edit a title as in the following example:

Race : %0-%2, %1 --- %3 %4 %5
The above title line will be sent to the scoreboard as:
Race : 18-A, Final --- Men 100m Freestyle

Official judge name:
The official judge name is meaned for the printed results. The name that is edited in this field will
replace the name that has been set into the ARES-Print Utility.

5.2 Editing the Start lists
To edit a start list, select the competition and the heat on the timetable dialog box and click the <start
list> button.

The competitors are taken from the competitor table. Click the <Add> button, to obtain the competitors
table.

The competitors are inserted at the selected entry in the list box of the start list edit dialog.

From the competitors table, select a competitor with double click (or press the <Enter> key) for
entering into the start list.

5.2.1 Editing a competitors name
Use this dialog to update or insert names in the competitors table.

<ld>: This is a number used by the software that uniquely defines every competitor.
<Bib>: This is an optional identification number or text.
It can be the id, can be let empty, or can take the value assigned by an external data handling,

to ensure the coordination between the two systems.

Press <ESC> to quit this dialog.

5.2.2 Editing the competitors table

To edit the competitors, go to the ARES-Swimming window, menu <Table - Competitors Table >
Edit>.

To add or modify a competitor, go to the competitors list, click on the <Edit> button to add or modify a
competitor.

To add a new competitor, select a new bib number or an empty bib number.

To modify a competitor, select his bib number.

5.2.3 Changing the order of a start list
This dialog is accessed from the <Start list> dialog, with the button <Reorder>.

A competitor is sent to the start list with double click on it.
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The competitors may be sent in any order.

5.3 Race dialog

The configurations available from the race dialog are:
e The lane options.
e Arm delay.

This dialog is accessed from the Timetable window, with the button <Race>.

The race dialog must be launched to process a competition. You don’t need to quit this dialog to
obtain the next heat.

FlI @

H Arm start |
B LA B C D

[Fo0A00m) 1 I

] s 1]

On title lane:

A) Shows the reaction Time

B) Indicates the lap distance on the total distance for each side.
C) Number of lap expected for this side.

D) Stage of race (start, intermediate, finish).

E) Displays the arm delay.

On the other lanes:

A) Relay or reaction times.

B) Times

C) Number of lap done.

D) Status of the touchpads (See Arm the lanes).

E) Direction expected and rank.
Start:
F) Arm status.

G) Running time.
H) Arm start button.

Configuration:

) Shows the contacts configuration for each side.

Note: There is a keyboard accelerator for the main functions and to select the popup menus
(numbers 1 to 0, 0 is the 10" lane).

5.3.1 Select the active side
For a two harness configuration:
e The active side has a red background.
e The active side is the one that reacts on actions, for instance an <arm All lanes>.
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o Selection of the active side is done by clicking the mouse on a side of any lane, or through
the <Actions - toggle side selection <Space> menu.
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For a one harness configuration:
There is only one active side, i.e. the finish side.

5.3.2 Popup menus for the lanes

Popup menus for the lanes appear by either right clicking on the time field for each lane, or by
pressing the number of the lane. (press 0 for lane 10).

For a two harness configuration, the popup appears on the selected active side.

The lane that has the popup menu is greyed.

5.3.3 Arm the lanes

Usually the lanes are automatically armed after the arming delay (user selectable). But you can
override this property by selecting arm On or arm Off.

arm ON : all the lanes should be ready to accept a touch.
arm OFF : all the lanes won’t accent any touch.
arm AUTO: all the lanes accept or not a touch, depending on the arming delay.

The lanes status can be selected
e individually : through the Popup menus for the lanes
¢ for all lanes: through the menu action of the race dialog.

eI,

a] bl c d € fl g

a) Lane is not armed (due to arming delay).
b) Lane is armed (after the arming delay).
c) Lane is being touched.
d) Lane is unused.
e) Lane is not armed (due to user actions).
f) Lane is armed (due to user actions).
g) Lane has completed expected laps.

5.3.4 Arm the start

When the race dialog is created, the start contact is armed.
After a start is received, the start is disarmed.

Note: If you want to restart a race, after a false start, just arm the start with the button. ||

5.3.5 Manual start

To simulate a start :
e Check the start is armed.
e press the <Ctrl> and <Shift> keys
e and click on the status symbol for the start.

ARES Swimming - Page 16



Ei SPORTS luumo

5.3.6 Manual time

To simulate a touch on the touchpad :
e press the <Ctrl> and <Shift> keys
e and click on the status symbol for the desired lane.

Or
e press the <Ctrl> and <Shift> keys
e and press the key '0’,’1".....’9’ of the desired lane.

5.3.7 Arming delay

Normal

17 After start

OK | Cancel |

This dialog is accessed from the Race window, with the menu <Options > Arm delay>.
This option controls the automatic arming process.
There are two arming delays to enter:

1. During the race : The arming delay should be a little less than the fastest time a swimmer can
swim back and forth along the pool.

2. Just after the start : The arming delay should be a little less than the fastest time a swimmer can
swim from the start until the opposite end.

5.3.8 Lane options
This dialog is accessed from the Race window, with the menu <Options - Settings>.

This dialog sets some options for all lanes.

Warning if no time:
Check it if you want to be warned when a swimmer doesn’t get a time (too soft touch, abandoned...).
The lane that received a <no time> warning has a blinking time entry.
The reaction when a lane gets a warning should be:
o Get the backup time if available, or make a <Lap +1> if the swimmer doesn’t touch the pad.
¢ Disarm the lane if the swimmer has abandoned.

Erase intermediates after ...:
An intermediate time will be erased from the screen and from the scoreboard after x seconds.

Beep on touch:
If checked, the computer will emit a beep for every new valid time.

A different sound can be played if your computer has a sound device

ARES Swimming - Page 17
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5.3.9 Next heat and next event.
To switch to the next heat:
e Be sure the race dialog is active.
e Select the menu <Actions > Next heat>.

To switch to the next event:
o Be sure the race dialog is active.
e Select the menu <Actions = Next event>.

5.3.10 Actions during a race
<Lap -1> : Decrement the lap counter and arm the lane.

<Lap + 1>: Increment the lap counter.

<Edit Finish time>: Launch a dialog to enter the finish time. It is possible to introduce 0.0 for a
swimmer who has not finished the race.

<Take Backup time>:
o If the lane is armed <On>, it will take the backup time for the expected lap.

o If the lane is armed <Off>, it will take the backup time for the lap that just occured.

Examples:
- The touchpads are not armed and a swimmer is arriving:

1. Select the side (if two harnesses).
2. Popup menu of the lane.
3. Arm the lane.
Or faster:
1. Select the side (if two harnesses).
2. Arm all the lanes. (With the accelerator keys)

- A swimmer arrives, but gives too soft a touch. You want to increment his lap number :
1. Select the side (if two harnesses).
2. Popup menu of the lane.
3. Lap +1;

- A swimmer arrives, but gives too soft a touch. You want to take the backup time :
1. If lane is still armed, increment his lap count (see above).
2. Select the side (if two harness).
3. Popup menu of the lane.
4. Backup time;

- A touch has been received before the swimmer arrives. You should decrement his lap number :
1. Select the side (if two harness).
2. Popup menu of the lane.
3. Lap -1; (the lane is automatically rearmed, and is ready for the real touch).
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5.3.11 Retrieve race
From the <Race> dialog, menu <Actions>.

This action is mainly useful in two cases:

a) You started the wrong race:
1. Quit the <Race> dialog
2. Connect the actual heat to the <Race> dialog (from the <Timetable> dialog).
3. Select <Retrieve race>.

b) You missed the start:

This means that the heat.was not connected to the race when the start occurs.
Select <Retrieve race>.

View the list of events in the <Events> dialog (<F6>)

Select the start event in the list (normally it is the first one).
Activate this start (<Actions > Validate).

Return to the <Race dialog> (<F5>).

arON =

5.4 Result dialog

5.4.1 Copy and paste results

These functions may be very useful if you have processed the wrong race. See also <Retrieve race>
in the <Race> dialog chapter 5.3.11.

For instance, you processed the final A, but in fact it was the final B that took place. So you should
move the result from the final A to the final B.

Copy results : Select the heat from which the results should be moved and click on the <copy> menu.
Paste results : Select the heat to which the results should be moved and click on the <paste> menu.

5.4.2 Available configurations

The configurations available from the result dialog are:
e Records settings.
e The ‘Before the race’ records editing.
o End of race actions (for printing).

The result dialog is launched when a heat is being connected to the race.
It may also be launched from the <Timetable> window, pushbutton <Result>.

End of race:

This dialog is used to view the final and intermediate results. The button <End of race> is used to
launch a printed result, or to update a result file. Select the actions to be taken when <End of race> is
pressed with the menu <On End of race - Options>.

Records:

o Manually set a record:
To set manually a record (e.g. NWR or NER), select in the listbox the lane where the record should
appear, and launch the <Records - Options> dialog.
Select a record type in the combobox.

ARES Swimming - Page 19



Ei SPORTS luumo

Use the <Clear> or <Set> button to set a record for the selected lane in the <Results> dialog.

e Record detection:
To choose if records should be detected automatically, go to the <Records - Options> dialog.
The program compares the time of the winner and any record of the three levels of records. If the
record is beaten, the <new record text> is added after the finish time.

¢ Record update:
The program asks to update the record table when the <End of race> action occurs.

o Edit a record
The records that where valid before the selected race and that appear on the print can be modified
with <Records - Edit for print>. Note that the records for the print are updated by the program on
<End of race>.

To remove a record for the print, call the edit record dialog, and set an empty text in the time entry
(chapter 6).

Disqualifying a lane: enter its number in the <Status - Disqualified> entry field.

5.4.3 End Of Race Options (printed results)
This dialog is accessed from the <Results> dialog, menu <End of race - Options>.

With this dialog, you can select which actions will be done when the button <End of race> of the result
dialog is pressed.

H Note: normally just one box should be checked.

<Direct...>:
¢ If your have an Internet browser, the program will use it to generate the result page (HTML
file). You must select if you want to have preview (HTML preview) or not (HTML) in the
combobox on the right.

e Select TXT or TXT Preview to print the result using Notpad program.

e Select %D to save the result in a unique file name in the data directory. The filename will
be "sEEERRHH.ixt" (EEE: event number, RR round number, HH heat number).

<Print program> : Default.
¢ the results are sent to the ARES-Print program, which is connected with a DDE interface.

<IF-ARES serial printer> :
o the results are sent to the micro printer that can be connected directly onto the IF-ARES.

<Update result table file>:
o the results are added to a text file that could be imported into a database.
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6. Records options

6.1 Editing the records table.
To edit the records, go to the main window, menu <Table - Records Table > Edit>.

To add or modify a record, go the records list, click on the <Edit> button.

A record can also be added or modified from the <Race dialog>.

6.2 Edit the record from the race dialog

The records for the heat that is on race are displayed on top of the race dialog.
From the race dialog, the menu <Records - Edit> lets you modify or add these records.

To delete a record, call the edit record dialog, and set an empty text in the time entry.

6.3 Updating a record

This dialog will appear in 3 cases:
¢ When editing the records table. (Button edit from the record list) (chaptere 6.12)
¢ When editing the record for the race that is active. (from the race dialog).
o When a new record is being put automatically in the records table.

Kind of record: There are 3 levels (like WR, ER, NR). The texts for these kinds of records can be
edited (for example to use CR in place of ER, etc).

Note: For fast editiing, you don’t need to type the punctuation for the times.
e.g you can type <12254> for <1:22.54>

To quit this dialog, press <ESC>.

6.4 The record output dialog
This dialog is accessed from the ARES-Swimming window, menu <Configuration - Records output>.

The dialog controls the outputs of the records, and also some other exportation data functions
(startlists, ...). This can be used to drive a TV character generator or for a Scoreboard.

Clear Pushbutton:
Send the command to clear the fields depending of the mode definition. This button may be simulated
with an external connection on the Line2 input of the IF-ARES.

Manual Pushbutton:
Send the datas as defined in the mode. This button may be simulated with an external connection on
the L3 input of the IF-ARES.

Mode:
<Default>: the output is done on IF-ARES SCB port.
Rec1 and Rec2 before the start & before the finish.
Rec1 before the intermediates.
Difference of the time compared with Rec1 after an intermediate.
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H Note: the user can edit his own mode. See Advanced in help file for the syntax of the configuration file. ||

<Follows event>: The records are automatically sent .

6.5 Record split times

Distance Time
=] =]
=] =]
OK | Cancel |

This dialog is used to edit the split times for a record. You can open it in the following way <Table »>
Records Table - Edit > Edit - Split time records>

The left-hand list shows the distances, the right-hand list displays the times for each distance.

Note: For fast editing, you also don’t need to type the punctuation for the times.
€.g you can type <12254> for <1:22.54>

When a record is beaten, these lists are automatically modified.

The split times are mainly used with the <Records output > option.
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7. Event Dialog

= Events n

Actions

Selection Pover M & B

|Right :ISide [

[ 1

I izt

- tane |

[—] O view an1

Lane Dist. Time

6 -
3: -
B: -
- -
6 -
5: -
4: -
3: -
Z: -
1: =

This dialog is accessed from the <ARES-Swimming> window, with the menu <Windows - Events>

This dialog is used to check all the information that comes from the pool.

This dialog displays a list of the all the individual times coming from the pool. The times are assigned
to the race that is currently connected to this dialog (it is usually the same race as the one in the
<Race> dialog).

When no race is connected, the times are just displayed, but never stored.

This window could be minimize with the accelerator key <F6>.

Modifying an time:
o Validate: Set the selected time as the significant time for this lap.
e Lap +1: Set the selected time as the significant time for the next lap.
e Lap-1: Setthe selected time as the significant time for the previous lap.

Editing a new time:
A time cannot be changed. But a new time can be added.
Select the side (if two harnesses are used), select the lap and select the lane and then click on the

edit menu.

The list of times.
A line in the listbox appears like this:
<source><status><lane><lap><time><harness>.

the source
T : touchpad
B : manual pushbutton backup.
<> : false start time for a relay race or reaction time.

space :other (edited, ...).
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the status:
V] : a valid time.
[VIM :avalid, manually generated time (from the keyboard).
[VIE :avalid, edited time (from the keyboard).

[*] : an time that occurs when the lane was armed, but has been invalidated.
: an time that is non-significant.

M : manually generated (from the keyboard).
E : edited (from the keyboard).

———
—_ e —

the lap: this is the lap number for this time. A *’ is added if the lap has been changed for this
time.

the time: the time elapsed from the last valid start.

the harness: <- : the time comes from the left harness.
-> : from the right harness.
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8. Scoreboard.

L=l DH  Configuration  T:

On 1<Chil Inzerts
v Off 1<Chl Homes

Send fran et Mianager F
Send additional information...
Results 1<Chl Pagelp>

Draytime

Freezed |<PALISE>

The scoreboard commands are accessed from the ARES-Swimming window.

<Onrace>: The scoreboard follows the race.

<Send from Meet Manager> : Popup menu which allows to send Startlist, Finish list, Women's scores,
Men's scores or Mixed scores from Meet Manager software database.
It's only available if a computer running Meet Manager is connected to
the GP port of the ARES.The ARES software is absoloutly transparent
and it send those information in ERTD mode on the ARES scoreboard
(SCB) port.

<Send additionnal information...> : Allows to send additionnal number like team score on a 12" line on

the scoreboard. This menu is only available in UNT4 modes
<Results> : The score board displays the result of the heat that is connected to the <result> dialog.

To send the first page: Press <Scoreboard - Results>.

If no hold time is set, do the following to send the next page: Press <Scoreboard ->
Results>.

To resend the first page: Press <Scoreboard > Off> and then press <Scoreboard ->
Results>.

Displaying the result of a previous race.

On the timetable dialog, select the competition and the heat

Uncheck the < 1: follows race>.

Click the <Results> pushbutton. to connect the selected heat to the results dialog.
And set the scorboard for <Results>.

el

<Daytime>: Sends the daytime to the score board. (Don’t forget to synchronize the IF-ARES ! ).

<Freezed>: Frezzes the current result on SCB (Use this option between each event to let results on
scoreboard).
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Configuration from the setup window:

Elsce - on = B
IB 'l Linesz per page

|3 Hald time per page

Kind Reaction Time &t Start
M Rs48s I Enable
[UNT4 Rank ~]| |¥ Mask Running Time

The Scoreboard setup dialog is accessed from the ARES-Swimming window, menu <Configuration ->
Scoreboard >.

<Number of lines>:  This setting is useful to send the results page by page.

Hold time: For scoreboards that have less lines than there are lanes in the pool, it is
possible to send the result page by page.
A hold delay in seconds can be entered. If no time is set, the following page is
sent on the <Result> actions.

Kind of scoreboard: Select the kind of score board you have: - GALACTICA Scoreboard (chapter 9)
- ERTD Scoreboard (chapter 10)

<RS485> : means that the data for the SCB is also sent to the RS485 pins of the SCB connector on
the IF-ARES.

H Note: The output on the 20mA pins is always active, no matter if the RS485 is checked or not. ||

Reaction Time At Start: Enable check box option allows you to show the reaction time when
competitors left the platform, and the option Mask Running Time check box removed running time on
scoreboard when the first reaction time is displayed .

The SCB output protocol is provided for free in our web site (www.omega-electronics.ch) in the ARES
Download section.
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9. DH control.

The DH commands are accessed from the ARES-Swimming window.

Configuration  Tables [F-ARES w
v [n
aff

v Meet Manager Software connected

Official end
Send rezults...

<Onrace>: the DH output follows the race.

<Meet Manager Software connected> : This item is automatically checked if a computer running Meet
Manager software is connected to the GP port of the ARES
and if it has made a Timing Consol Test.

<Send results> : the DH output sends the result of the heat that is connected to the <result> dialog.

The DH-Send results dialog is accessed from the ARES-Swimming window, menu <DH - Send

results>.

<With backup>: check it if you want the backup time to be sent.

The GP output protocol is provided for free in our web site (www.omega-electronics.ch) in the ARES
Download section.

9.1 DATA HANDLING OPTIONS (from version 2.15)

DH Options |

The data handling communication can be
—IF-4RES GP PORT

done through two different channels:

 None
a) via a serial port on the ARES PC. [from & DSME
revision 215] ' DSMEWith presence message
b) viathe IF-ARES GP port ~ B dvactionl

~OH ON PC COM PORT

 None
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9.1.1 DH Connection via the ARES PC secondary com port

If the ARES PC has two serial ports (COM1 and COM2), one of them is always used to link the PC to
the IF-ARES. The other one can be used to link ARES to a data handling PC.

ARES PC

A null modem cable can be used or alternatively a 3 ways cable as described in the following table.

Cable socket DB9 Female Cable socket DB9 Female
pin 2 (RX) pin 3 (TX)

pin 3 (TX) pin 2 (RX)

pin 5 (GND) pin 5 (GND)

9.1.2 DH Connection to the IF-ARES GP port
To connect the IF-ARES GP port an Data Handling PC, a RS485 - RS232 Converter is required.

RS232 / RS485
converter

< [ep]  [pc]

Data Handling PC ARES PC

The cabling to that converter is described in the table bellow:

Cable plug IF- CONVERTER Cable socket
ARES end PC end

DB9 Male RS485 RS232 DB9 Female
pin 2 * (RX+) TX + RX pin 3 * (TX)
pin 3 (TX+) RX + TX pin 2 (RX)
pin 6 *(TX-) TX - GND pin5 (GND)
pin 7 (TX-) RX -

* can be omitted in OSM6 mode

The serial port settings is preset by the software (see also configuration->serial port->DH)
OSM®6 types: 9600 7 even 1
Bi-directional type: 9600 8 none 1.
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10. GALACTICA Scoreboard

Startlists:
The startlists are sent to GALACTICA (Swimming interface) through the option "Record Outputs
The startlists may be sent a Il in one shot or individually.

How to send all the startlists:

Activate <The record output dialog > (chapter 6.4).

Select the mode "GALACTICA Startlist".

Press the "Manual" pushbutton to send the startlists. In GALACTICA, the swimming interface
displays the names as they come in.

How to send a startlist for one race:

Activate the <Race dialog> (chapter 5.3)

Activate <The record output dialog > (chapter 6.4).

Select the mode "GALACTICA Startlist".: cur. Heat".

Press the "Manual" pushbutton to send the startlists. In GALACTICA, the swimming interface
displays the names as they come in.
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11. ERTD Scoreboard

The ERTD type is designed to drive DAKTRONICS scoreboards running with the VENUS software.
For these kinds of scoreboards, the startlists are sent at the launch of each race (when the Race
dialog is open, or when a Next Heat command is given).

The refresh of the scoreboard may be done with the SCB-On and SCB-OFF commands.
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12. Text modification

12.1 Text modification of the definition of competition

In the swimm-folder you can find files of languages (*.tx0 English, *.tx1 Francgais, *.tx2 Deutsch , *.tx3
Italiano, *.tx4 Espariol) that you can edit and modify without problem. If these files don’t exist, you
have to create for example with the help of notepad.

12.2 Text modification of interface

You have the possibility to redefine the different messages that appear on the screen. To do this you
have to open the swimm.msO0-file in the swimm-folder for example with help of notepad, copy the line
of the message that you want to change, close the file Attention: Don’t make modifications in this
file!, create the new file, paste in the line and then change the text.

Registrate the file under the name of user.msg. All your modified texts should be found in this file.
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13. Glossary

backup button

Competition:

A competition is a group of heats

Data directory:

This is the directory were all the results, the configuration, competitors and records tables are stored.
There is also a copy of the default tables (style, round, length, category) for the selected language.

Default directory:

This is the directory were the program resides. It contains all the default tables, in all the supported
languages

LED:

This is small red lamp in front of the IF-ARES.

ARES Module:

A piece of software that is active in the IF-ARES. It should have been downloaded from the PC using

the <Download program>. Lastest version of ARES Module is provided for free in our web site
(www.omega-electronics.ch) in the ARES Download section.

platform

touchpad

OMEGA
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